DeskCNC setup and operation manual

This document explains how to install, setup and cut foam shapes using
DeskCNC 4 axis foam cutting software.

The document will go through a step by step process of how to setup the
software and make simple to complicated cuts to maximize the use of the
software.

DeskCNC was designed for a 3 axis CNC router type machines, at a later stage
it was modified to enable a 4" axis need to run an automated 4-axis foam cutter.
If you have purchased DeskCNC for your foam cutter, you can also use it to drive
a CNC router table or a similar 3-axis machine.

This document explains the following three chapters:
e DeskCNC Software Installation
e DeskCNC Software Setup
e Making Sample cuts tutorial plus examples

DeskCNC Software Installation
If your product did not come with pre-installed DeskCNC software, please follow
these steps to install it on your Windows PC.

1. Download the latest DeskCNC software from this web site:

www.deskcnc.com
2. Double click the DeskCNC file and continue the installation
3. Once the installation has finished, turn on the power to the controller box
and click on the DeskCNC icon to run the program

DeskCNC software Setup
Please follow the next steps very carefully in order to assure the correct
operations of the machine and software.

1. Turn on the DeskCNC box or the driver box (which has the DeskCNC
electronics inside

2. Click on the DeskCNC icon.

3. The 1° message on the screen should be “Hardware detected”

4. If you get “hardware not found” this means that the software on the PC
does not recognize the DeskCNC electronics, and you will not be able to
proceed without fixing this.

5. Usually this message will show if the DeskCNC electronics are not
powered up or the serial cable is not connected between the PC and the
DeskCNC electronics.



6. Click on “Setup”, then choose “Options”

7.
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In the Options category, click on the Post Processor pull down menu and
select the FourAxisLinear once selected, click on the Save Button
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8. Click on “Setup” and choose “Machine Setup”
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9. Make sure to set the values to the exact values shown in the screen shot
below, once done, click on the “Save” button
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10. Click on “Machine Setup” once again.
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Axes - Click on the “4” option with the number 1 arrow pointing to

A Axis - Click on “Linear” option with the number 2 arrow pointing to
Click the checkbox on the “2" Generation Controller” with the number 3
arrow pointing to. Once done, click on the “Save” button



11.Next click on the Axes Setup as shown below
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The steps per In. values will change from one machine to the other
depending on the lead screw use — Please refer to the setup page which
came with you machine

12.Notice that X-axis “Steps per In.” has a [-] in front of the 1500.000
this is intended to make this axis move the “other” direction. This is used
when the machine was setup and each axis is manually moved for testing
purposes. If an axis moved the “wrong” direction, place the [-] sign in front
of the value. Once done, click on the Save Button

13.Note the red rectangle — To Reverse Direction, make Steps per in Unit
Negative — as explained above in item 12

Setup of DeskCNC is now complete — you are ready to start cutting



Manual Control

Each of the 4 axis can be move independently.

In the screen shot below,

RT X+ : Click on this button and the Right X axis will move forward
RT X - : Click on this button and the Right X axis will move Backwards
RT Y+ : Click on this button and the Right Y axis will move Up

RT Y - : Click on this button and the Right Y axis will move Down

LF X+ : Click on this button and the Left X axis will move forward

LF X - : Click on this button and the Left X axis will move Backwards
LF Y+ : Click on this button and the Left Y axis will move Up
LF Y - : Click on this button and the Left Y axis will move Down
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Feedrate Overrride

When the machine is running (cutting), the cutting speed can be increased or
decreased. By holding down the override slide, and moving it to the left, the
cutting speed will decrease.
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G code

G code can be entered (in a command line) and run in the top left corner of the
screen as shown below. This is useful if the user wants to move the machine to a
specific location. In the example below, the machine will move 10” on all 4 axis

with a speed of 77 inch per min SF77 is Feedrate of 772
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0 Axis

Click this button (the one with the red arrow pointing to) and the XYZA values will
change to 0. In the screen shot there are already 0, but this feature is useful if
you manually move any of the axis, and set your starting point. Once you set
your starting point, click on the All button and that will clear the 4 axis values.
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When manually moving any or all of the axis, jog speed can be set to different
speeds.

Click on the Jog pull down menu, and set the desired speed.

Once the desired speed is set, click on the RT X+ or any of the other buttons to
move the axis with this new speed settings.



Reset — Estp (Emergency Stop)

By Default, when the software is started, the Reset button will be “pressed” and
the Axis buttons are “grayed” out — no active.

Click once on the Reset button and the buttons will become active.

If during a cut or an automatic movement of any of the axis, you wish to stop the
machine, simply click once on the Reset button and all movements will stop
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Making sample cuts
Single shape cut:
In this example we take a single shape and prepare it for a cut.
DeskCNC will accept DXF file format for its foam cutter operation.
Since the machine is a true 4 axis machine — it can cut one shape on the left side
of the machine and a different shape on the right side. For an example. A square
on one side and a circle on the other. In the below example, both shapes are the
same. AutoCAD was used to generate the shape in the example
1. Load the shape to the left side of the machine
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By default, DeskCNC will place the same shape on both sides, but if a different
shape is needed for the Right side of the machine, simple click on Foam Cutter
once again and this time choose the Right side and load the desired shape




2. Click on the file that you wish to load, in this example we load the Shape with
name of “f’
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In the above screen shot, the shape of a letter F was chosen.
Suppose the letter must be rotated to fit into the block of foam — in the following
steps we will rotate, resize and position the shape as needed.



1. Rotate the shape:
Before rotating the shape, DeskCNC must know what you want to rotate,
In this example we will rotate the entire shape. In order to rotate the entire shape

we muse first select it.
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Click on Select, and then choose “Select All” — as shown above.
If this step is skipped, once in the rotate menu, an error message will pop stating
that nothing was selected, and the rotation can’t be done



Once selected, proceed to rotate the selected shape.
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Click on “Edit DXF”, then choose the last option in the pop down menu “Scale,
Move, Rotate selected”



2 ADeskCNC - Foam Cutting Mode [F.dxF]
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In this example, we will rotate the shape in 90 deg angle. Enter the deg of
rotation and then click on the Rotate button



The rotated shape is now in light blue color as shown below
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The new shape (the rotated one) should now be saved under a different name,
Lets save it as f rotated in 90 deg testing
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Now enter the name of your new file - f_rotated_in_90_ deg_testing



B IDeskCNC - Foam Cutting Mode [F.dxf]

File Mode EditDxF Setup Select Yiew Toolpaths Help

savens 2| x|
Save in: Ia DeskCNC ﬂ - £k Ea-
ADVANCED Foamlinx3
ADVANCED] LoLA 2410
cnclinz10 LOLA 24_10_2
enclinz10_5%_5 POCKTUT
DRILLTUT PROFILES
f TREE
F_90_small
F_90_small_st_0_Sx0_5
fon
e [M0vve, Scale, and Rotate Fon_3inch
Foarlin:
~Selection Parameters
Bottom Left X -12.9686
Bottem Left Y  0.0000 File name: If_lotated_in_SD_deg_testing j Save I
Center X -6.4843 Save az lype: IDXF Files = D) j Cancel |

Center Y 4 4366 -

|9I].I]I]
Top Right X  0.0000 Rotation Axis J
Top Righty  8.8733 ® ® o
Move To Ornigin | 1
Crale I i

Enter the new name and click on the save butto

At this stage you should have a new DXF file with the name
f rotated_in_90_ deg_testing.

Now we need to load this new shape for further manipulations.
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ADeskCNC - Foam Cutting Mode [F.dxf]

File Mode Edit D¥F Setup Select Miew Toolpaths  Help

Open DxF

Open STL

Open HPGL
Cpen Point Claud

Open Top/Left/Larger DXF Contour
Open BotkomRightfSmaller DxF Contour

Qpen Gerber 3
Open Image 4
Open NC 4
Digitize w7
Foarm Cukker 4
Save Geometry DEF
Save Toalpaths CHiT
Saye Tonlpath) DxE
Add Text
View Lag File b
Close
Exit (
ale, and Rotate
—Selection Parameters
Bottom Left X  -12.9686
Bottem LeftY  0.0000
Center X -6.4843
Center 7 4 4366
Top Right X 0.0000
Top RightY 88733
Scale |

—Enter Hew Parameters

Bottom Left X

Bottom Left ¥

Scale Factor

Rotation Angle

Rotation Axiz—— |

=X [ ¢

|-1 2. 9686
Il].l]l]l]l]
II].I]I]I]I]I]

90.00

wZ

Move To Ongin

Center On Onigin
Load the new image by clicking on the “File”, then “Foam Cutter”, then
“Open Top/Left/Large DXF Contour” as shown above
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The new shape is now loaded but it is on the left side of your grid — in other
words, if you try to cut this shape, you will notice that the cut will be outside the

foam.

We need to move the shape to the 0,0 coordinates.
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In order to move the new shape we must first select it — as before click on the
“Select” Menu, then select All.



Once selected, click on the “Edit DXF” and choose the “Move, Scale and Rotate”
option
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Click on the “Move to Origin” button on this new window as shown above and
you will see that the new shape (now in Blue) has moved to the right side of the
coordinates.

Now save the new image with a new name say
f rotated_in_90 deg_moved_to_0_testing



Like before, save the new shape by clicking on the “File” menu, then
“Save Geometry DXF” option, and give the new name,,, say
f rotated in 90 deg moved to 0 testing

EDeskENE - Foam Cutting Mode [f_rotated_in_90_deg_testing.DXF]
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There are a few more options that can help you manipulate the shape, like
resizing, and moving, we will not show all here, but try to experiment with these
options to get familiar with them. We find that the most useful features are
moving scaling and rotating the shapes




Now lets move the shape to 1,1 coordinates
Load the image and follow the below steps
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And then 1 for the Bottom Left Y
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Once you entered 1 for the bottom left x box and 1 for the bottom left Y box, click
on the “Move” button, and you should see that the new shape now in blue has

moved.

Like before, save this new shape under a different name, and then load this new

image






Now load this new shape:

Once the new shape is loaded, click on the “View” button and choose the
“‘information Tags”.

Information are numbers that tell you where the machine will start cutting and
where it will move next. In our example you will notice that is only one number.
The reason being that this shape is viewed by the software as a single shape.
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The number 1 also tells you that the software chose this point and it will start
cutting from that point and finish there as well.

T

At this point we would like to move this point to a different position. The reason
for moving this point is that the machine always start cutting from 0,0, and we
would like it to start the actual cut as close as possible to the starting position.



In this next step we will set the new starting position at the bottom left side of the
shape.
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Click on “Edit DXF” and choose “Change Start/Depart”




Notice the message at the bottom left of the screen !l
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This step is very important!!!
You now have to use the two mouse buttons, the right mouse button and the left
mouse button.

Left Click to set Skark Poink - Right Click to set Depart Paoink,

Like in the message in the screen shot, To set the staring point use the left
mouse button and the set the depart point click on the right mouse button.



Place the mouse curser at the point where the purple arrow is pointing and click
on the left mouse button

EDES'(ENI: - Foam Cutting Mode [f_rotated_in_90_deg_moved to_1 1 testing.DXF]
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At this point you should see that the left side of the shape is now Blue.

1




Now set the mouse curser to where the purple arrow is pointing to as shown
below

EDESI{ENE - Foam Cutting Mode [f_rotated_in_90_deg_moved_to_1_1_ktesting.DXF]
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Notice that the bottom side of the shape is now Blue.

The above two steps told the machine to start from the bottom left of the shape
and depart from the bottom right side of the shape (where the above purple
arrow is pointing at)




We are now ready to create the tool path — tool path is the G code that runs the
machine and tells it where to go step by step

To create the tool path click on the “Toolpath” button and choose “4 Axis Foam
Cut’
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Enter the Feed rate — in this example we used 33 inch per min, Feed rate is
dependent of the type of foam you use. ‘ ‘
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Click on the “Create” button.
Now the shape should have turned to Black as shown below.

ﬂDeskENE - Foam Cutting Mode [f_rotated_in_90_deg_moved_to_1_1_testing.DXF]
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Now click on the Toolpaths button once again and choose “Run Machine”

EDeskENE - Foam Cutting Mode [f_rotated_jin_90_deg_moved_to_1 1 testing.DXF]
File Mode Edit D¥F Setup Select  View | Toolpaths Help

Clear

4 Axis Faam Cuk

Fun Machine

Click on the “Save” button — this will save you G code for this specific shape
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Cutting multiple shapes — nesting

Nesting is used when there are more then a single shape to be cut.

The goal is to place the shapes as close as possible to each other in order not to
waste more material then needed.

Placing the shapes is done with the design software — AutoCAD, CorelDraw or
any other drawing software that can save its output as DXF file.

Once the file containing multiple shapes, load it into DeskCNC just as a single
shape was done.

In the following example, we take a file containing 4 shapes, and prepare it for
the cut.



In this example we will load a DXF file which has 4 shapes:
From the “File” menu choose “Foam Cutter” and load the file
4 chainwheels_exploaded.dxf, this file can be found on the CD included with
your machine.
Software detected 4 shapes and it numbered then 1,2,3,4
In this example we did not move the 4 shapes to Origin.
In order to move the shapes to Origin, please follow the steps in the previous
example - From the Select menu choose “Select All”
From the Edit DXF menu select “Scale move rotate selected”
Click on the “move to Origin” — at this point you should see the new 4 shapes in
blue color moved to the origin.
Save the DXF under a new name say... 4 chainwheels exploaded at 0 0

E!DeskCNE - Foam Cutting Mode [4_chainwheels_exploaded.d=f]
File Mode EditD#F Setup Select View Toolpaths Help
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In the screen shot above, the Green lines with pointed by the red arrows show
the path that the software decided to run between one shape to the other, if you
would to cut these shapes with this configuration, the shapes would be cut, but in
addition to the shape, the lines pointed with the red arrows would be cut as well,
ruining the project.

To fix this we would need to set the order of the cut as well as to tell the software
where to start cutting each shape and where to exit each shape.




Changing the machining order — this step will tell the software which shape will
be cut 1% and which 2" and so on

EDeskEHE - Foam Cutting Mode [4_chainwheels_exploaded.d=f]
File Mode | Edit DXF Setup  Select  Yiew Toolpaths Help
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Click on “Edit DXF” and choose “Set Machining Order”
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Notice the numbering with the red square around them — these will change in the
next steps.
Software detects 4 shapes — click on the OK button



Click on each shape (it does not matter where on the shape you click).
Each click will change the number on the shape indicating the sequence it will be
cut

EDeskENE - Foam Cutting Mode [4_chainwheels_exploaded.d=f]
File Mode Edit DXF Setup  Select  Wiew Toolpaths Help
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Notice that after this stage the sequence is a bit different then the sequence that
the software decided once the file was loaded. The new sequence is now marked
with blue squares around the new numbering.

You can set any sequence you like, there is no wrong sequence, but the idea is
tell the machine to move from one shape to the other in the shortest route.

Click here 4th




Changing the start of the cut and the depart of the cut

ﬂDESkENE - Foam Cutting Mode [4_chainwheels_exploaded.d=f]
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In the next few steps, we will change the start of the cut for each shape as well
as the depart point of each shape.

The Start point is where the wire will first hit the shape and start the cut, the
depart is where the wire will exit the shape in order to move on to the next shape.
The goal is to get the wire to move from one shape to the other in the minimum
distance.



Once you click on “Change Start/Depart” option you will get a message on the
bottom left side of the screen. Two of the mouse buttons will be used in this
phase. The Left mouse button to set the start and the Right mouse button to set
the depart point of the wire.
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Left mouse Click at the point where the arrow is pointing as shown on the screen
shot below. Notice that the line from shape number 1 is now connected to shape

number 2
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Now we need to set the depart point out of shape number 1
Right mouse click where the red arrow is pointing.
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At this stage we set the depart point of the wire from shape number 1.
The next step is to tell the software where we want to set the start point of shape
number 2.

We will try to get the start point of shape number 2 to be as close as possible to
the depart point of shape number 1



To set the start point of shape number 2, click on the point shown with the red
arrow in the picture below
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We will now set the depart point of shape number 2.

Right Click at the point there the red arrow points to as shown below
S ‘\._“_‘_‘_'_._.__..r c

—




Now set the start point of step 3, again the goal is to have the shortest route
connecting shape number 2 to shape number 3
Left mouse click on shape number 3 at the point shown in the picture below
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Now we will set the start point of shape number 4
Left mouse click on shape number 4 as shown b}/ the arrow
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The last step is to set the depart point of shape number 4
Right mouse click on the shape number 4 at the point shown with the arrow

below
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All'in all there should have been 8 mouse clicks. Two for each shape.

A start click for each shape and a depart click for each shape.

In the picture below notice the red arrows — they show how and where the wire
will exit one shape and go to the next shape

Notice that each shape has two colors, blue and green.

When the machine will start cutting, it will start from the bottom left side of the
shapes, with shape number 1, it will follow the green path and continue to shape
number two following the green path, it will continue to shape 3 and 4 on the
green path.

Once in shape 4, it will start going back to the original starting point, but this time
following the blue path .



The next and last step is to cut the shapes
From the ToolPath menu, choose the 4 Axis Foam Cut

E!DeskCNC - Foam Cutting Mode [4_chainwheels_exploaded.d=f]
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Set the feed rate according to the foam used
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Click on the “Create” Button, and save the file.
At this stage, the file name is the file containing the 4 axis G code that will run the
machine.




